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Learning Management System Guide

1 Introduction
This document provides LMS Administrators with the necessary information to install and use the
eReserve LTI Tool for those LMSs that support LTI V1. and above (e.g. Moodle, Desire2Learn,
CanvasLMS, Blackboard, etc).

As part of the education industry and Learning Management System standard LTI1.3, and in order to
show the degree of student engagement to academics and to identify at risk students and prevent
them from dropping out, an institutions LMS using LTI 1.3 will pass eReserve Plus limited amounts of
student data. The student data includes the following:

• First name
• Last name
• email address
• LMS ID (an ID that is assigned to that student user of the LMS)
• student ID.

All data is securely stored and is handled with care, secure data handling procedures and in
compliance with legal requirements and best practice security mechanisms.

1.1 Prerequisites
Before the connection between the Learning Management System and eReserve Plus can be created,
it is required that the LMS Admin has knowledge of the Domain Name that the institution has created.
The Domain Name is a vital piece of information that is used to form part of the connection between
the Learning Management System and eReserve Plus. If you do not know your Domain Name, please
contact the eReserve Support Team.

1.2 Support
Should you require additional assistance please contact the eReserve Support Team on
support@ereserve.com.au and a technical representative will contact you to assist.
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2 Overview of Installation
Installation of the eReserve Plus LTI Tool starts in the eReserve Plus Configuration console. Following
are the steps necessary to complete the installation.

2.1 Integration Record Creation
Creation of new integration records is done within the eReserve Plus Admin interface. You will need
access to this interface to complete this step of the setup. If you do not have access then please
contact the eReserve Support Team.

Each integration record contains the details for authentication (a key and a secret) and, once activated
it will contain details of the LMS Instance once it has been activated.

Login to eReserve then navigate to Configure > Integrations.

Once you have navigated to Integrations, you will see the interface pictured below.
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To start the creation process click on the New integrations for dropdown button then select IMS LTI
Tool.

You’ll then be presented with the form below. All you need to do is enter a name for your integration
then click on the Save button. You’ll notice that a key and secret have been automatically created for
you. Take note of these, we’ll be using them when we head over to your LMS to do the next step.
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At this point it’s important to note that each instance of your LMS will need its own integration record
created in eReserve. So if you have 3 instances of your LMS you’ll have 3 integration records in
eReserve. Once an integration record has been activated it can only be used with the LMS instance
that it was activated from. So using those credentials for another LMS Instance will fail.

2.2 Installation in your LMS
Each LMS that supports IMS LTI 1.1+ has its own specific installation requirements. With this in mind
we’ve created instructions for each LMS that we support. These can be found in section 3 of this
document onwards.

2.3 Reading list access management
Every user from your LMS has a role as defined in the LTI standard (see LTI Role Vocabularies). The
role is passed to eReserve Plus at the time a user accesses their Reading List in eReserve Plus.
Subsequently this role is then used to dictate what features the user has access to in the reading list.
Currently there are two access levels defined in eReserve Plus: Student and Academic. The Student
role provides read only access to the Reading List where as the Academic access provides a fully
featured reading list management interface. You can manage this access simply by editing your LTI
Integration record once it has been activated through the eReserve Plus Integration Management.
Once you’ve started editing your LTI integration, you will see a LTI Role Access console to manage like
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the image below.

You’ll note the list of LTI roles with their associated access level. Rows that are green have had their
access level set and those that are red have not. To set or change the access level it’s just a matter of
clicking on the edit button. Once clicked you’ll see the form below.
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Change the name as needed and select an appropriate access level then click on the save button
and you’re done. This will be updated immediately and end users will see the change.

The first time an LTI role attempts to access eReserve Plus, the role will be made available in red as
per the screenshot above until the Role is mapped in eReserve Plus to a Student or Academic; at
which time it which will become green (authorised). If there are Roles in your LTI which have not
become available in eReserve then login using the LMS using the appropriate role and select the
Reading List activity to initiate the first access of eReserve Plus.

2.4 Reading lists, unit codes and unit names
When displaying the Reading Lists eReserve Plus will use the unit code from your LMS to know which
Reading Lists to display. For a lot of Institutions the unit code will change each time it is offered. For
example, a unit code for one offering may be CS101_S2_2014 and the next offering the unit code may
be CS101_S1_2015. There are commonalities, however they are unique to the offering of the course
and will mean that eReserve Plus will not have any historical lists for the new code. This is solved in
eReserve Plus through its unit code filtering.

2.4.0 Unit Code Prefix

In very special circumstances a prefix can be added to all unit codes connecting from the integration. If
utilised all unit codes originating from the integration will have the prefix added and all unit code filters
will have to be setup based on the prefixed unit code.

2.4.1 Unit code filter

To map a newly created offering to a base code, eReserve Plus has a filtering mechanism that allows
you to match the new offering to the base unit code (e.g. CS101 in the example above). To set the
filtering simply edit the associated integration record in the Intergration Management interface and
complete the Unit Code Filter field. To create a filter you will need to provide a Regular Expression.
You can use tools like Rublar to test your regular expressions before applying them to your integration
record.

NB: It’s important that this unit code filter is correct otherwise it will lead to incorrect display of
Reading Lists. If you are not comfortable with creating a regular expression then please contact the
eReserve support team.

2.4.2 Unit code matching field

The majority of Learning Management Systems will send the Unit Code via the LTI Context Label and
the Course Description will be in the LTI Context Title. If the Base Code is only available within the
Course Description this option sets which LTI field is processed by the Unit Code Filter.

2.4.3 Unit code match flattening

If set to yes all text captured by the regex is joined together in the resulting Base Code.
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2.4.4 Example unit code filter

This example is based on a unit code with the format below.

<base_code>_<teaching_period>_<year>

We’ll be using the following unit code samples for testing Rublar: CS101_S2_2-14 and
CS101_S1_2015. Below is a test of the regular expression created for filtering.

As you can see our regular expression (i.e. ^[\s\S]{0,5} ) has matched the base_code and we can now
apply it to our integration record simply by entering it in the Unit Code Filter field then saving the
integration record. So every time the unit is offered eReserve Plus will only look at the base_code when
choosing a reading list to display.
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2.4.5 Unit name filter

The LTI Unit Name Filter allows unnecessary detail and other content about the course to be removed
from the unit name displayed within eReserve Plus.

When utilised the LTI Unit Name filter allows the display of course long names to be modified to fit the
display requirements of the reading list within eReserve Plus. Long course names can be modified to
better fit the layout, course code and reading list display within the eReserve Plus interface.

2.4.6 Unit name match flattening

In the same manner as the Unit Code Filter if set to yes all text captured by the regex is joined together
in the resulting course name.

2.4.7 Example unit name filter

The Unit Name Filter can be designed to remove the Course Code and Time Period which in eReserve
Plus will be represented by the Unit Code and eReserve Plus reading list name. The matched string for
the Unit Name would be Civil and Criminal Procedure.

^[\s\S]{0,5} ([^-]*) - .*20\d\d$

When eReserve receives the LTI handshake from the LMS, it will receive the string CS101 Introduction
to Computational Theory - Semester One 2015, however it will only store and display Introduction to
Computational Theory.
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Blackboard LMS
Throughout this section of the document are the details on getting your Blackboard Learn instance
connected to eReserve Plus using LTI 1.3 and using Resource Linking or Deep Linking. Should you
have any questions then please contact the eReserve Support Team at support@ereserve.com.au

3.1 Requirements
The eReserve Plus LTI Tool is regularly tested with the Blackboard Learn SaaS releases supported by
Blackboard. It is important to note that we will only be testing against the Blackboard Learn SaaS.

It is also required that a ClientID has also been received from the eReserve Team. If you have not
received the ID yet, please contact the eReserve Plus support team.

Blackboard Learn can only have one LTI Tool per domain so if there is an LTI 1.1 Tool
configured for eReserve Plus then that will be required to be deleted prior to configuring an
LTI 1.3 Tool

3.2 LTI Tool Providers
In the Admin Panel for Blackboard, select LTI Tool Providers under Integrations, then select Register
LTI 1.3/Advantage Tool.

From there, you can enter in the ClientID that has been provided by the eReserve Team.
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Once the LTI 1.3 Tool has been registered, it will create the tool along with automatically populate the
following details:

• Name
• Description
• Deployment ID
• Initiate Login URL
• Tool Redirect URLs
• JWKs URL

The Domain field is required to be populated with the domain of the eReserve Plus environment. i.e.
example.ereserve.com.au.
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The Tool Status will require to be set to Approved, by deafult this option is set to Excluded.

Under Institution Policies, all tick boxes for the User Fields to Send, will require to be Enabled or
ticked and for the Service access will require to be set to No as per the following screenshot.
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3.3 LTI Tool Placements
In order for course maintainers to link to a Reading List in eReserve Plus in their courses you will need
to create placements for the Tool provider created in step 3.2. There will be three different placements
required for the LTI 1.3 tool. The placements are Course content tool, Administrator tool and Deep
Linking content tool. To create placements for an LTI Tool Provider, the dropdown option can be
selected while hovering over an LTI Tool Provider, then Management Placements can be selected.
Details for configuration can be found below:

Course Content Tool
Below will be the required information for the creation of the Course Content Tool placement.

1. Label: The placement Label can be named anything you like to suit your institutional vocabulary
however we recommend something that is relevant to the placement as this will be displayed in
courses.

2. Handle: The placement Handle uniquely identifies the placement.
3. Availability: The placement Availability will determine whether the placement will be available or

not - This should be set to Yes.
4. Type: The placement Type will need to be set to Course Content Tool with the Allows Grading

option disabled.

Learning Management System (LMS) Integration Guide

PDF last generated: February 21, 2022 Page 14



The Tool Provider Information will require the Target Link URI to be populated. An example of that link
can be found below:

• https://example.ereserve.com.au/app/integration/lti/reading_list/launch where the
example.ereserve would be your eReserve domain.
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Administrator Tool
Below will be the required information for the creation of the Administrator Tool placement.

1. Label: The placement Label can be named anything you like to suit your institutional vocabulary
however we recommend something that is relevant to the placement as this will be displayed
under Tools and Utilities in the Administrator Tools.

2. Handle: The placement Handle uniquely identifies the placement.
3. Availability: The placement Availability will determine whether the placement will be available or

not - This should be set to Yes.
4. Type: The placement Type will need to be set to Administrator Tool.

The Tool Provider Information will require the Target Link URI to be populated. An example of that link
can be found below:

• https://example.ereserve.com.au/app/integration/lti/reading_list/launch where the
example.ereserve would be your eReserve domain.
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The Tool Provider Customer Parameter will require to have the following parameter:

• user.system.role=@X@user.role@X@

Deep Linking Content Tool
Below will be the required information for the creation of the Deep Linking Content Tool placement.

1. Label: The placement Label can be named anything you like to suit your institutional vocabulary
however we recommend something that is relevant to the placement as this will be displayed in
courses.

2. Handle: The placement Handle uniquely identifies the placement.
3. Availability: The placement Availability will determine whether the placement will be available or

not - This should be set to Yes.
4. Type: The placement Type will need to be set to Deep Linking Content Tool with Student

Access disabled.
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The Tool Provider Information will require the Target Link URI to be populated. An example of that link
can be found below:

• https://example.ereserve.com.au/app/integration/lti/resource_link/generate where the
example.ereserve.com.au would be your eReserve domain.
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Once the above have been completed, you will be able to Authorise and Activate the LTI1.3 Tool for
the creation of Resource Links.

3.4 Authorisation
To Authorise your platform you will need to use the following steps:

1. Login as a Blackboard Administrator
2. Navigate to the Administrator Tools;
3. Click on the eReserve Plus Admin Tool in the Tools and Utilities panel;

(NB: If you have chosen a different eReserve Plus Admin Tool name than what is
recommended in Section 3.3 then you will be looking for that name)

4. You will be present with a Authorise your LMS instance;
5. Click on the Authorise button;
6. If you have not logged into your institution’s eReserve Plus instance then you will be presented

with a login page. Login in with an account that has the Site Manager role. If you do not have
an account then please contact the eReserve Support Team;

7. Once logged in you will see a notice letting you know that the authorisation is complete;
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NB: You will need to be logged in as a Blackboard Learn Administrator and also have an
eReserve Plus account with the Role of Site Manager in your institution’s eReserve Plus
instance which matches your Blackboard Learn instance (i.e. For Staging environment
configuration, you will need to have an eReserve Plus account with the Site Manager Role
in your eReserve Plus Staging instance to complete the registration).

The first message displayed is the IMS LTI Platform Authorisation which outlines that your platform has
not been authorised to use eReserve Plus. In order to Authorise the platform, click Authorise and you
will be taken to the Admin interface of eReserve Plus where you will need to have the Site Manager
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role to complete the authorisation.

On Authorisation you will see a notice appear at the top of the eReserve Plus Integration Management
page. This notice will contain details of the success or failure to authorise your LMS to use your
institution’s eReserve Plus instance.

3.5 Activation
Once you have authorised the platform (i.e. your LMS instance), you will be asked to refresh your page
and then complete the Activation of the Registration (see below) for your platform so that users will be
able to access eReserve Plus via the LMS instance.

3.5.1 Reading lists, unit codes and unit names
When displaying the Reading Lists eReserve Plus will use the unit code from your LMS to know which
Reading Lists to display. For a lot of Institutions the unit code will change each time it is offered. For
example, a unit code for one offering may be CS101_S2_2014 and the next offering the unit code may
be CS101_S1_2015. There are commonalities, however they are unique to the offering of the course
and will mean that eReserve Plus will not have any historical lists for the new code. This is solved in
eReserve Plus through its unit code filtering.

3.5.2 Unit Code Prefix

In very special circumstances a prefix can be added to all unit codes connecting from the integration. If
utilised all unit codes originating from the integration will have the prefix added and all unit code filters
will have to be setup based on the prefixed unit code.

3.5.3 Unit code filter

To map a newly created offering to a base code, eReserve Plus has a filtering mechanism that allows
you to match the new offering to the base unit code (e.g. CS101 in the example above). To set the
filtering simply edit the associated integration record in the Integration Management interface and
complete the Unit Code Filter field. To create a filter you will need to provide a Regular Expression.
You can use tools like Rublar to test your regular expressions before applying them to your integration
record.

NB: It’s important that this unit code filter is correct otherwise it will lead to incorrect display of
Reading Lists. If you are not comfortable with creating a regular expression then please contact the
eReserve support team.

3.5.4 Unit code matching field

The majority of Learning Management Systems will send the Unit Code via the LTI Context Label and
the Course Description will be in the LTI Context Title. If the Base Code is only available within the
Course Description this option sets which LTI field is processed by the Unit Code Filter.
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3.5.5 Unit code match flattening

If set to yes all text captured by the regex is joined together in the resulting Base Code.

3.5.6 Example unit code filter

This example is based on a unit code with the format below.

<base_code>_<teaching_period>_<year>

We’ll be using the following unit code samples for testing Rublar: CS101_S2_2-14 and
CS101_S1_2015. Below is a test of the regular expression created for filtering.

As you can see our regular expression (i.e. ^[\s\S]{0,5} ) has matched the base_code and we can now
apply it to our integration record simply by entering it in the Unit Code Filter field then saving the
integration record. So every time the unit is offered eReserve Plus will only look at the base_code when
choosing a reading list to display.
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3.5.7 Unit name filter

The LTI Unit Name Filter allows unnecessary detail and other content about the course to be removed
from the unit name displayed within eReserve Plus.

When utilised the LTI Unit Name filter allows the display of course long names to be modified to fit the
display requirements of the reading list within eReserve Plus. Long course names can be modified to
better fit the layout, course code and reading list display within the eReserve Plus interface.

3.5.8 Unit name match flattening

In the same manner as the Unit Code Filter if set to yes all text captured by the regex is joined together
in the resulting course name.

3.5.9 Example unit name filter

The Unit Name Filter can be designed to remove the Course Code and Time Period which in eReserve
Plus will be represented by the Unit Code and eReserve Plus reading list name. The matched string for
the Unit Name would be Civil and Criminal Procedure.

^[\s\S]{0,5} ([^-]*) - .*20\d\d$

When eReserve receives the LTI handshake from the LMS, it will receive the string CS101 Introduction
to Computational Theory - Semester One 2015, however it will only store and display Introduction to
Computational Theory.
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3.5.10 Reading list access management
Every user from your LMS has a role as defined in the LTI standard (see LTI Role Vocabularies). The
role is passed to eReserve Plus at the time a user accesses their Reading List in eReserve Plus.
Subsequently this role is then used to dictate what features the user has access to in the reading list.
Currently there are two access levels defined in eReserve Plus: Student and Academic. The Student
role provides read only access to the Reading List where as the Academic access provides a fully
featured reading list management interface. You can manage this access simply by editing your LTI
Integration record once it has been activated through the eReserve Plus Integration Management.
Once you’ve started editing your LTI integration, you will see a LTI Role Access console to manage like
the image below.
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You’ll note the list of LTI roles with their associated access level. Rows that are green have had their
access level set and those that are red have not. To set or change the access level it’s just a matter of
clicking on the edit button. Once clicked you’ll see the form below.
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Change the name as needed and select an appropriate access level then click on the save button
and you’re done. This will be updated immediately and end users will see the change.

The first time an LTI role attempts to access eReserve Plus, the role will be made available in red as
per the screenshot above until the Role is mapped in eReserve Plus to a Student or Academic; at
which time it will become green (authorised). If there are Roles in your LTI which have not become
available in eReserve then login using the LMS using the appropriate role and select the Reading List
activity to initiate the first access of eReserve Plus.

3.6 LTI Link Placement
Once the LTI Tool Providers (section 3.2) and LTI Tool Placements (section 3.3) have been created/
completed, people who are responsible for course content management can put the LTI links in
Blackboard Learn courses or templates.

3.6.1 LTI Link Placement within Course Content - Classic Experience

To create a link in course content firstly, make sure that editing for the course is turned on.

Then navigate to the course content then click on the Build Content and then select the Course
Content Tool i.e. Reading List (see below).

Please note that the name Reading List is the name of our placement that we created earlier (see 3.3
LTI Tool Placements - specifically the Course Content Tool)
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Once you have selected the Course Content Tool, you’ll then see the create form (see below). All you
need do is fill in the Name for the link then click on the Submit button. All other fields are optional and
can be set as needed.
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After creating the link it will be displayed in the course content. To get to the reading list for eReserve
Plus it’s just a matter of clicking on the link that was created. Depending on your role you will either
see a read only reading list (e.g. for students) or the reading list management (e.g. for course builds,
academics, etc.)

3.6.2 LTI Link Placement within Course Menu - Classic Experience

Within your courses you can create a link in the course menu to eReserve Plus using Course Links. To
create the link in the course menu you must have already created a Course Content Tool (see 3.6.1).
Once you have the Course Content Tool you can use the following steps to create a link in the course
menu.

1. Make sure course editing is turned on.
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2. Click on the Add Menu Item button
3. Click on the Course Link menu item.
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4. Once clicked, the Add Course Link form will be displayed (see below). Click on the Browse button
to select the Location.
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5. Once clicked, you will see the Select Course Link form. Choose the content link you created earlier
by clicking on it. In the example below it’s the Reading List in the Content folder.

6. Once you’ve selected the content link tick the Available to Users checkbox, change the Name as
you see fit then click on the Submit button. The link will now appear in the course menu.
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3.6.3 LTI Link Placement - Ultra Experience

To create a link in course content, first select the create menu and select the Content Market menu
item.
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From there, hover over the Course Content Tool that we created earlier (in this case it is labelled
Reading List DEV) which is under Institution Tools and select the plus symbol in the button right corner.
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Once selected, it will automatically be added to the Course Content section. Hovering over it, you can
click on the ellipse to edit and change the name and make it available to student.

3.7 Editing the Registration Form
To edit the Registration Form or to change details such as the Unit Code Filter or LTI Role Access, you
will be required to be logged in as an Blackboard Administrator.

From there, you will need to navigate to Admin and at the bottom of Tools and Utilities, there is an
eReserve Admin menu item. Once selected, it will take you to the Re

3.8 Resource Linking with Blackboard
Once the LTI Tool Providers (section 3.2), LTI Tool Placements (section 3.3) and the LTI Link
Placements (section 3.6) have been created/completed, people who are responsible for course content
management can put the LTI links in Blackboard Learn courses.

3.8.1 Resource Linking - Classic Experience

For the Classic Experience of Blackboard, you will be able to use the following documentation to
create Resource Links. To add and create Resource Links, navigate to Course and select Content.
Once there, select the Build Content dropdown and select the Resource linking tool that was created
earlier (this will be named when the Deep Linking Content Tool was created in section 3.3 - In this
case, it has been labelled Resource Linking).
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From there, it will take you through the steps to select a Reading List and Resources to add.
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Once the link has been created, it will display by default as LTI Link however this can be changed by
editing the Content item and changing the name to suit.

3.8.2 Resource Linking - Ultra Experience

For the Ultra Experience of Blackboard Learn, you will be able to use the following documentation to
create Resource Links within Course Content.

Resource Links can be created and added where there is an HTML editor (i.e. Documents
and Discussion)

A video can be found on how to create Resource Links below.

For the following documentation, we will create a new Document. To add and create Resource Links,
navigate to create a new Document (see below) and select the menu item to create new course

Learning Management System (LMS) Integration Guide

PDF last generated: February 21, 2022 Page 36



content.

Once selected, select to create a new Document.
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From there, select Add Content.

You will be presented with an HTML Editor. Select the Insert Content dropdown fromt he menu and
select Insert/edit LTI item
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Under Institution Tools, select the Deep Linking Content Tool that was created earlier in section 3.3 of
this document - In this case, it has been labelled Resource Linking.

Once selected, you will be presented to select a Reading List and resources to add as Resource Links.
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Once the Resource Link/s have been selected, created and resized, it will display in the document
HTML editor.
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Brightspace LMS
Throughout this section of the document are the details on getting your Brightspace instance
connected to eReserve Plus. It’s very important to read all of the details in section 2 of this document,
and complete all of the activities in this section. Section 2 deals with the setup required on the
eReserve Plus side, including the generation of the LTI Key and Secret. Should you have any questions
please contact the eReserve Support Team at support@ereserve.com.au

4.1 Requirements
The eReserve Plus LTI Tool is regularly tested with the Brightspace releases supported by D2L. It is
recommended that you use a D2L supported version of Brightspace however the eReserve Plus LTI
Tool has been tested with earlier Brightspace versions without incident. This document covers
configuration of Brightspace hosted by D2L.

4.2 LTI Advantage Access
In order to configure and manage LTI Advantage Tools you will need to configure permissions on the
roles for those staff performing these tasks. When logged in as the Super Administrator you do the
following for the roles that need the access:

1. Click on Roles and Permissions in the Security section of the admin settings menu.
2. You will be presented with a table of roles.
3. Select the role name that you want to give admin access and manage the LTI Advantage Tools

and select External Learning Tools for the Filter by Tool option.
4. Tick the two options for LTI Advantage Tools (see screenshot below)
5. Click Save and Close
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Figure 1: Admin User Role Permissions
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4.3 LTI Advantage Registration
To complete the registration of your eReserve Plus instance within D2L Brightspace, please follow the
detailed instructions found here: Register an External Learning Tool for LTI Advantage

Below are some samples for the population of key fields on the registration form:

• Name Enter a name to identify the registration is for your eReserve Plus instance. (e.g.
eReserve Plus Staging)

• Domain Enter the Domain of your eReserve Plus instance. (e.g. https://eu.ereserve.com.au)

• Redirect URLs You will need to populate the following Redirect URLs
◦ Resource link Generation: https://eu.ereserve.com.au/app/integration/lti/resource_link/

generate
◦ Reading List View / Manage https://eu.ereserve.com.au/app/integration/lti/reading_list/

launch
◦ Resource Link View: https://eu.ereserve.com.au/app/integration/lti/resource_link

• OpenID Connect Login URL You will need to populate the following URL:
◦ https://eu.ereserve.com.au/app/integration/lti/login

• Keyset URL You will need to populate the following URL:
◦ https://eu.ereserve.com.au/app/integration/lti/public_jwk.json

• Extensions Select the Deep Linking option only

• Roles Tick Send Institution Role

Ensure that you enable the registration. You also need to take note of the Client ID, this will allow you
to locate the registration within the integration records in your eReserve Plus instance.

4.4 LTI Deployment
Once the registration has been completed, Deployments and be created based on the registration.
Following are the steps to creating a Deployment for eReserve Plus.

1. Edit the created registration in Brightspace
2. Scroll to the bottom of the page, and select View Deployments link
3. You will be presented with a list of deployments, click on the New Deployment button
4. The Deploy Tool form will be displayed. Complete the form as follows:

1. Tool Select the registration (e.g. eReserve Plus Staging)
2. Name Enter a name to identify the deployment is for your eReserve Plus instance (e.g.

eReserve Plus Staging)
3. Security Settings Tick all options except Anonymous
4. Org Units Add the Org Units that will be using eReserve Plus

5. Click in the Save & Close button
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Figure 2: Creation of LTI Deployment

4.5 LTI Link Creation
Once the Deployment has been created, you will need to create links to allow access to eReserve Plus.
This is completed on the links page for your deployment. To navigate to the Links page, for your
deployment, use the following steps:

1. Edit the eReserve Plus deployment in Brightspace
2. Scroll to the bottom of the page, and click on the View Links page
3. You will now see the Links page

Now that you are on the Links page you can create the required links. Follow these steps for each link.
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List View/Management

This link can be used for the management of the list for a site when you have the role of Instructor or to
simply view the list for the site when you have the role of Learner.

1. Click on the New Link button
2. Complete the form as follows:

1. Name Provide a name to identify this is the List View/management tool (e.g. Resource
List)

2. URL https://eu.ereserve.com.au/app/integration/lti/reading_list/launch
3. Type Choose the Basic Launch option

3. Click on the Save & Close button

Figure 3: Creation of List View/Management Tool
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Resource Link Creation

This link allows Instructors to create new Resource Links in HTML Content

1. Click on the New Link button
2. Complete the form as follows:

1. Name Provide a name to identify this is Resource Link creation tool (e.g. Resource
Linking)

2. URL https://eu.ereserve.com.au/app/integration/lti/resource_link/generate
3. Type Choose the Deep Linking Insert Stuff option

3. Click on Save & Close button

Figure 4: Creation of Resource Link Tool
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4.6 eReserve Plus Activation
To activate the registration record in eReserve Plus you will first need to make the List View/
Management tool available in a site.

1. Navigate to your site in Brightspace
2. In the site content, click on the Existing Activities button
3. Choose the External Learning Tools option
4. Choose the List View/Management link created in the LTI Link Creation section
5. The link will appear on the page

You are now ready to start the activation. Please note to complete this activation, you will need to have
a user account in eReserve Plus with the role of Site Manager. Following are the steps for activation

1. Click on the link you created earlier
2. You will be asked to authorise your Brightspace instance. Click on the button provided
3. You will be presented with the login page for your eReserve Plus instance, login with you Site

Manager account.
4. Once authenticated you will see a notification saying your Brightspace instance has been

authorised to use eReserve Plus
5. Return to Bright space then reload the page
6. Confirm the details are correct, such as the Unit Code Filter, Roles are assigned correctly etc.
7. Click on the Activate button.

Once the above steps have been completed you can then add the List View/Management link to other
sites via the Existing Activities > External Learning Tools menu item. For resource links you can use
Inset Stuff.
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Moodle LMS
Throughout this section of the document are the details for getting your Moodle instance connected to
eReserve Plus. It’s very important to read all of the details in Installation (see section 2 of this
document) and complete all of the activities in this section which will result in a successful connection
to eReserve Plus. Should you have any questions please contact the eReserve Support Team at
support@ereserve.com.au

5.1 Requirements
The eReserve Plus LTI Tool is regularly tested with the releases supported by Moodle. It is
recommended that you use a Moodle supported version of Moodle however the eReserve Plus LTI
Tool has been tested with earlier Moodle versions without incident. It is important to note that we will
not be testing against older versions of Moodle as where support has been withdrawn by Moodle.

5.2 LTI Management
In order for course maintainers link to a Reading List in eReserve Plus for their courses you will need to
create a configuration in the Moodle LTI Management interface. To get to this interface you will need to
be logged into Moodle as an Administrator then navigate to the following location in Moodle:

Click on the configure a tool manually then fill out the form as follows:

Tool Settings

Learning Management System (LMS) Integration Guide

PDF last generated: February 21, 2022 Page 50



1. Tool Name - You can name this as you need but we recommend eReserve Plus

2. Tool base URL - This URL will be provided by the eReserve Support Team along with this
document.

3. Consumer Key - The key in the integration record that you created earlier.

4. Shared Secret - The secret in the integration record that you created earlier.

5. Launch Container - This is how the External Tool will be displayed. Below are the options:

◦ Default - If in doubt, leave as default;
◦ Embedded - The External Tool will be embedded in the Moodle course page with

blocks and navigation bar;
◦ Embedded without Blocks - The External Tool will be embedded in the Moodle course

page but without blocks;
◦ New Window - The External Tool will open in a new window (A new window or tab will

open with the External Tool and the old browser window containing the course page will
not change.)

Tip: It is our recommendation that you configure the Launch Container to be Embedded
without Blocks as a default to ensure the Reading List size available to users is optimised.
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Privacy

1. Share launcher’s name with tool - This is set to Always for eReserve to pre-populate reading
requests with a User’s name.

2. Share launcher’s email with tool - This is set to Always for eReserve to pre-populate reading
requests with a User’s email address.

3. Force SSL - All communication with eReserve Plus is done over SSL so this needs to be
ticked.
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NB: eReserve Plus does not store Student emails or names. These settings are purely for recording
reading requests from Academics.
Once you have completed the form just click on the Save Changes button. You’re now ready to create
a link in a course.

5.3 Course Link to Moodle
The LTI Tool integration in Moodle is treated as an ‘Activity’. So for those who maintain the course, its
just a matter of adding a new activity in an appropriate location in Moodle. Just navigate to the course
in question then click on the Turn editing on button, if you haven’t already. Once in edit mode just
click on Add activity or resource link.

Learning Management System (LMS) Integration Guide

PDF last generated: February 21, 2022 Page 53



Once you’ve clicked on the link you’ll see the Add an activity resource dialog displayed (see below).
Choose the External tool option then click the Add button.
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The Adding a new External tool form (see below) will be displayed. Fill it in as follows

1. Activity Name This name can be chosen by the course maintainer but we recommend
eReserve Plus or Reading List

2. External tool type To use the configuration you created earlier just select the eReserve Plus
option.
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All other options can be left with their defaults. Click on Save and return to course and you’re done.
Now onto activation of your integration record.

5.4 Integration Record Activation
This is the final step and the most important one. It binds your Moodle Instance to the integration
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record within eReserve Plus. To do this is very simple, it’s just a matter of clicking on the link you
created in the course. If you’ve chosen the Embed option then you’ll see something like the page
below for those who have access to manage the Reading List.

Once this has been done if you return to eReserve Plus and navigate to Configure > Integrations
you’ll note the integration record has been activated with the details of your Moodle Instance.

Before activation:
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After activation:
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Now that your integration record has been activated it’s important to configure it correctly so please
read 2.3 Reading list access management and 2.4 Reading lists and unit codes to apply your desired
configuration details.

5.5 Resource Linking with Moodle
There are four plugins which make Resource Linking for Academics and Teachers possible from
Moodle:

• eReserve Plus Local Plugin
This plugin contains all of the core functionality for the integration between the two platforms.
For the end user this is where all of the configuration is done.

• eReserve Atto & TinyMCE Plugins
This plugin allows for integration with eReserve Plus. At this stage it focused on Resource
Linking. To support the insertion of resource links (link to a list of one or more resources in
eReserve Plus) this plugin provides a button that can be added to the Atto editor (now the
default editor for Moodle) and automatically added to the TinyMCE Editor.

• eReserve Plus Filter Plugin This plugin will make sure that the correct details are used such
as the Course ID and Reading ID when using Resource Linking.
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Download the necessary installation files here

Prerequisites

To use these plugins you will need an eReserve Plus instance and Moodle 3.3.4 or later.

Installing the plugins

File Copy / Upload

To start the installation of the plugins you can use one of the two following methods:

1. File Copy
If you have access to the file system for the target Moodle instance then you can kickstart the
installation by doing a simple copy in bash:

$ cp -rf path/to/repo/lib path/to/moodle/lib
$ cp -rf path/to/repo/local path/to/moodle/local

2. Zip File Upload
With this method you will need to zip each of the plugins using the following steps in bash

$ sh build.sh

After running the above script all of the zip files will exist in a build directory. You can upload
the zip files via the Moodle admin interface Administration > Plugins > Install
plugins. Once there, follow the on-screen instructions to do the installation.

Installation

After using either of the above methods to get the files onto your Moodle instance it’s just a matter of
visiting the Moodle administration page and Moodle will detect that the plugins need to be installed.
Follow the instructions laid out by Moodle providing the settings, which are detailed in the Settings
section of this document.

Atto Editor Post Installation

In order to have the eReserve Plus Resource Link button in the Atto Editor you will need to manually
add it via the Moodle administration. Navigate to Administration > Plugins > Text editors
> Atto HTML editor > Atto toolbar settings.
Once on the page scroll down to the Toolbar config then place ereserve in where you want the
button to appear. Following is an example configuration (note ereserve on the files line of the
config):
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collapse = collapse
style1 = title, bold, italic
list = unorderedlist, orderedlist
links = link
files = image, media, managefiles, ereserve
style2 = underline, strike, subscript, superscript
align = align
indent = indent
insert = equation, charmap, table, clear
undo = undo
accessibility = accessibilitychecker, accessibilityhelper
other = html

Filter Plugin Post Installation

Once the filter plugin has been installed you will need to enable the filter. This can be done in the
Moodle Site Administration using the following steps:

1. Login as an administrator
2. Navigate to Site administration > Plugins > Filters > Manage filters
3. Locate the eReserve Plus Filter then change Active? to On
4. Move the eReserve Plus Filter to the bottom of the list of active filters

Settings

General Settings

• eReserve Plus Host Name -
This setting is the fully qualified domain for your eReserve Plus instance (e.g.
[ereserve].institution.edu.au). This will be supplied as part of your onboarding. NB: Please do
not include the http:// or https:// portion of the URL

IMS LTI Settings

The following Consumer Key and Secret are generated in eReserve Plus by creating an integration
record associated with this instance of Moodle. Creation of integration records can be done within the
eReserve Plus admin interface via Configure > Integrations. For specific details please see the
eReserve Plus documentation

• Consumer Key
The Key from the associated integration record in eReserve Plus

• Shared Secret
The Secret from the associated integration record in eReserve Plus
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Canvas LMS
Throughout this section of the document there are details on getting your Canvas instance connected
to eReserve Plus. It’s very important to read all of the details in Installation and complete all of the
activities in this section which will result in a successful connection to eReserve Plus. Should you have
any questions then please contact the eReserve Support Team at support@ereserve.com.au

6.1 Requirements
The eReserve Plus LTI 1.3 Tool has been tested with the latest release of Canvas supported by
Instructure. It is recommended that you use a supported version of Canvas however the eReserve Plus
LTI Tool has been tested with earlier versions without incident.

6.2 Developer Key Creation
In this section, you will be required to create a Developer Key which will allow your instance of
eReserve Plus to connect to Canvas using LTI 1.3.

To create a Developer Key, you will need to be logged in as an Administrator user of CanvasLMS
instance and navigate to:

Admin > YourAccount > Developer Keys

From there, select to create an + LTI Key by selecting + Developer Keys.

Once selected, you will be presented with the LTI Developer Key creation form.
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Figure 1: Creation of Developer Key

1. Key Name: This name is for you to identify this developer key in the list of developer keys. You can
name it as you see fit.

2. Redirect URLS: You will need to provide the following URLs to allow CanvasLMS to redirect to
during launches:

Production Redirect URL:
- https://[ereserve].institution.edu.au/app/integration/lti/reading_list/launch
- (e.g https://ereserve.elysium.edu.au/app/integration/lti/reading_list/launch where “ereserve” is

the Domain Name and “elysium” is the institution name)

Staging Redirect URL
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/reading_list/launch
- (e.g https://ereserve-staging.elysium.edu.au/app/integration/lti/reading_list/launch where

“ereserve” is the Domain Name and “elysium” is the institution name)

3. Method: Choose the Manual method for creation of the developer key

4. Title: This is the name of the tool used in its placement (e.g. Course Navigation, Link Selection, etc).
This will be visible to academics and students so choose an appropriate name (e.g. Reading List,

Learning Management System (LMS) Integration Guide

PDF last generated: February 21, 2022 Page 63



Course Resources, etc)

5. Description: A brief description about the LTI Tool (i.e. eReserve Plus)

6. Target Link URL: This is the general launch URL for this developer key. You will need to provide the
following launch URL here:

Production Target Link URL:
- https://[ereserve].institution.edu.au/app/integration/lti/reading_list/launch
- (e.g https://ereserve.elysium.edu.au/app/integration/lti/reading_list/launch where “ereserve” is

the Domain Name and “elysium” is the institution name)

Staging Target Link URL
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/reading_list/launch
- (e.g https://ereserve-staging.elysium.edu.au/app/integration/lti/reading_list/launch where

“ereserve” is the Domain Name and “elysium” is the institution name)
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7. OpenID Connect Initiation URL

As a part of the authentication process Canvas LMS will require the eReserve Plus OpenID URL which
is as follows:

Production OpenID Connect Initiation URL
- https://[ereserve].institution.edu.au/app/integration/lti/login
- (e.g. https://ereserve.elysium.edu.au/app/integration/lti/login where “ereserve” is the Domain

Name and “elysium” is the institution name)

- Staging OpenID Connect Initiation URL
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/login
- (e.g. https://ereserve-staging.elysium.edu.au/app/integration/lti/login where “ereserve” is the

Domain Name and “elysium” is the institution name)

8. JWK Method Choose the Public JWK as the method and complete the following sub-steps to
obtain the JSON to enter.

a. In another internet tab/window, visit the following URL:

- Production JWK Method URL
- https://[ereserve].institution.edu.au/app/integration/lti/public_jwk.json
- (e.g. https://ereserve.elysium.edu.au/app/integration/lti/public_jwk.json where “ereserve” is

the Domain Name and “elysium” is the institution name)

- Staging JWK Method URL
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/public_jwk.json
- (e.g. https://ereserve-staging.elysium.edu.au/app/integration/lti/public_jwk.json where

“ereserve” is the Domain Name and “elysium” is the institution name)

b. Copy the resulting JSON displayed on the page

c. Paste the copied JSON in the field provided for the JWK

9. Additional Settings The Privacy Level will need to be set to Public in order for the Developer Key
and App to function correctly
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Figure 2: Privacy Level settings in the Developer Key creation
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10. Placements The Course Navigation and Account Navigation placements will need to be added in
order for once the Developer Key is created to be visible to users.

An example of the above with the information filled out can be found below.

Figure 3: Developer Key with example details populated

6.3 App Creation
Once the Developer Key has been created, you will need to install the Developer Key as an App. Below
are the steps to follow to add the Client ID as an External Learning Tool.

1. Client ID

The Client ID is the long number that is in the Developer Key record under the section Details (see
image below with red box)
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Figure 4: Developer Key - Client ID

2. App Configuration

Create the App by navigating to Settings > Apps > View App Configurations > + App

3. Configuration Type

The Configuration Type that should be selected is the By Client ID option where you will be asked to
enter the Client ID from the Developer Key

Figure 5: Adding the App by Client ID

Once the above has been completed, you will have an install dialog box display where you can
complete the installation of the App

When the Tool has been installed, the name of the External Learning Tool will be displayed on the left
sidebar navigation of the Administration home page. From that link you can start the process of
registering your Canvas LMS with eReserve Plus which can be found in the next section of this
document.
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Figure 6: External Learning Tool placements

6.4 Authorisation
Once the Developer Key has been created and setup, registration of your Canvas LMS with eReserve
Plus can be completed by clicking on the Developer Key Title in the sidebar navigation of the
Administration home page. This was entered in step 4 of the developer key creation.

NB: You will need to be logged in as a Canvas LMS Administrator and also have an
eReserve Plus account with the Role of Site Manager in your institution’s eReserve Plus
instance which matches your Canvas LMS instance (i.e. For Staging environment
configuration, you will need to have an eReserve Plus account with the Site Manager Role
in your eReserve Plus Staging instance to complete the registration).

The first message displayed is the IMS LTI Platform Authorisation which outlines that your platform
has not been authorised to use eReserve Plus. In order to Authorise the platform, click Authorise and
you will be taken to the Admin interface of eReserve Plus where you will need to have Site Manager
role to complete the authorisation.
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Figure 7: Platform Authorisation

On Authorisation you will see a notice appear at the top of the eReserve Plus Integration Management
page. This notice will contain details of the success or failure to authorise your Canvas LMS to use
your institution’s eReserve Plus instance.

6.5 Activation
Once you have authorised the platform (i.e. your Canvas LMS instance), you will be asked to refresh
your page and then complete the Activation of the Registration (see below) for your platform so that
users will be able to access eReserve Plus via the Canvas LMS instance. The on-screen details will
display the LTI Client ID which should match that of the Developer Key ID.

Complete the form then click Activate to complete the process.
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Figure 8: Platform Activation

It’s important to note that at this stage the placements will appear in your Canvas LMS. So placement
link “Course Navigation” will be visible for students and academics. Should they click on the link they
will be presented with a page (see below) alerting them that eReserve Plus is yet to be activated.

Figure 9: Academic and Student Alert of unactivated platform
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6.6 Testing your Configuration
Once you have completed the activation, eReserve Plus will be accessible in the placements that you
have chosen (see the Course Navigation placement example below). Each user accessing eReserve
Plus through the placement will be presented with the appropriate eReserve Plus page depending on
their Canvas LMS role.

Figure 10: eReserve Plus Reading List via External Learning Tool

6.7 Editing the Registration Form
To edit the Registration form or to change details such as the Unit Code Filter or to change an LTI Role
Access, you will be required to be logged in as a Canvas LMS Administrator.

From there you can navigate to Admin > YourAccount then click on the eReserve Plus Developer Key
link. From there you can update the Registration form.
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Figure 11: Editing the Registration for the Developer Key

6.8 Resource Linking with Canvas

6.8.1 Pre-requisites
The eReserve Plus Canvas Resource Linking has been tested with the LTI 1.3 Tool with the latest
release of Cloud Host by Instructure.

It is expected that an LTI 1.3 Tool (Developer Key) has been created and is currently in use. If it has
not, please refer to Canvas LTI 1.3 Documentation to create and setup.

6.8.2 Developer Key Amendments
The following information will be required to be changed in the Developer Key that you have created
for your LTI 1.3 Tool.

Redirect URLs
In the Developer Key that has been created, there will need to be two additional URLs that are required
to be added to the Redirect URL field, The URLs to add are as follows:
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- Production URL - Generate
- https://[ereserve].institution.edu.au/app/integration/lti/resource_link/generate
- (e.g https://ereserve.elysium.edu.au/app/integration/lti/resource_link/generate where

“ereserve” is the Domain Name and “elysium” is the institution name)

- Staging URL - Generate
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/resource_link/generate
- (e.g https://ereserve-staging.elysium.edu.au/app/integration/lti/resource_link/generate where

“ereserve” is the Domain Name and “elysium” is the institution name)

- Production URL - Resource Link
- https://[ereserve].institution.edu.au/app/integration/lti/resource_link
- (e.g https://ereserve.elysium.edu.au/app/integration/lti/resource_link where “ereserve” is the

Domain Name and “elysium” is the institution name)

- Staging URL - Resource Link
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/resource_link
- (e.g https://ereserve-staging.elysium.edu.au/app/integration/lti/resource_link where

“ereserve” is the Domain Name and “elysium” is the institution name)

This will mean that in total, there should be three URLs in the Redirect URIs field. See an example in
the screenshot below.

Figure 12: Developer Key with additional Redirect URLs
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Additional Settings
In the Additional Settings section, the Domain field will need to be populated with the domain that
you are currently using for your CanvasLMS.

Figure 13: Additional Settings > Domain

- Production URL - Domain
- https://[ereserve].institution.edu.au
- (e.g ereserve.elysium.edu.au where “ereserve” is the Domain Name and “elysium” is the

institution name)

- Staging URL - Domain
- https://[ereserve]-staging.institution.edu.au
- (e.g ereserve-staging.elysium.edu.au where “ereserve” is the Domain Name and “elysium” is

the institution name)
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Editor Button
In the Editor Button section, the Target Link URL and the Icon URL will need to be populated with
the following URLs:

Figure 14: Editor Button details

- Production URL - Target Link URL
- https://[ereserve].institution.edu.au/app/integration/lti/resource_link/generate
- (e.g https://ereserve.elysium.edu.au/app/integration/lti/resource_link/generate where eu is the

institution code)

- Production URL - Icon URL
- https://[ereserve].institution.edu.au/app/assets/fav.png
- (e.g https://ereserve.elysium.edu.au/app/assets/fav.png where eu is the institution code)

- Staging URL - Target Link URL
- https://[ereserve]-staging.institution.edu.au/app/integration/lti/resource_link/generate
- (e.g https://ereserve-staging.elysium.edu.au/app/integration/lti/resource_link/generate where

eu is the institution code)

- Staging URL - Icon URL
- https://[ereserve]-staging.institution.edu.au/app/assets/fav.png
- (e.g https://ereserve-staging.elysium.edu.au/app/assets/fav.png where eu is the institution

code)

This completes the configuration of Resource Linking with the CanvasLMS.

To learn more about eReserve Plus Resource Linking from a User perspective in the CanvasLMS,
please visit our Feature Guidance documentation.
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